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Introduction
This tutorial is designed to introduce the user to the features available in the WinPEST component 
of Visual MODFLOW. The tutorial will guide you through

• opening an existing model,
• attempting to calibrate the model manually,
• preparing the model for a PEST run, and
• using PEST to calibrate your model.

This tutorial is structured so that you, the user, can alter parameters as you see fit. This tutorial not 
only allows you to become familiar with both the advantages and limitations of the WinPEST 
package, it will also familiarize you with the software and assist you in the calibration of your 
own models. 
NOTE: Some features described in this tutorial are only available in a Pro or Premium version.

Project Background

Description of the Study Area
The following figure shows an alluvial valley in which three Pumping wells (Well_1, Well_2 and 
Well_3) and four head observation wells (Obs-w_1, Obs-w_2, Obs-w_3 and Obs-w_4) are located. 
The alluvial valley is comprised of a central portion of relatively high hydraulic conductivity and 
specific yield. However, near the edge of the alluvium the sediments become finer, and both 
hydraulic conductivity and specific yield decrease.

Groundwater processes within the valley will be simulated for a single year, subdivided into four 
stress periods. Recharge, which shows seasonal variation, is shown in the following figure. 

An Alluvial Valley
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Pumping rates from the pumping wells are also seasonally dependent (as shown in the following 
figures).
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The model is set up with 4 stress periods, each stress period is 91.3 days in length with 15 time 
steps, and a time step multiplier of 1.2. In the following figure, water levels at two of the 
observation wells (Obs-w_1 and Obs-w_2) are shown. This will become the “measurement 
dataset” when we calibrate the model.

In the following figure, the model domain zonation is based on the aquifer properties, displayed in 
the “An Alluvial Valley” figure (shown on page 1). 

                 Zonation used by the model
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Terms and Notations

For the purposes of this tutorial, the following terms and notations will be used:
Type:- type in the given word or value
Select:- click the left mouse button where indicated

- press the <Tab> key
↵- press the <Enter> key

- click the left mouse button where indicated
- double-click the left mouse button where indicated

[...]- denotes a button to click on, either in a window, or in the side or bottom menu bars.
Bold faced type indicates menu or window items to click on or values to type in.
In Visual MODFLOW Input window, when you move from one type of input to another (e.g. 
from Properties to Boundaries), you will be prompted to save the changes. Always choose Yes 
as long as the changes you made are in accordance with this tutorial. If you made other changes, 
use your discretion. If you click No in this message, all changes made after the last time you saved 
your model will be lost.

Getting Started with Visual MODFLOW
On your Windows desktop, you will see an icon for Visual MODFLOW:

    Visual MODFLOW to start the program

A set of Visual MODFLOW input files for this model has been supplied. 
File / Open from the main menu.

Locate the Visual MODFLOW file Valley.vmf file, located in the following folder: C:\My 
Documents\Visual MODFLOW\Tutorials\WinPest\. 

[Open]
You can inspect the model from the Input menu.

Input

Wells

To inspect the wells, we’ll first turn them ON in the Overlay Control:
[F9 – Overlay]
Click  on the Obs – Head tickbox (this makes the head-observation wells visible)
Click  on the BC(F) – Wells tickbox (this makes the pumping wells visible)
[OK]

Your display should appear as shown in the following figure. It shows an alluvial valley in which 
three pumping wells (Well_1, Well_2 and Well_3) and four observation wells (Obs-w_1, Obs-w_2, 
Obs-w_3 and Obs-w_4) are located. 
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Next we will look at the pumping wells a little more closely.
   Wells>Pumping Wells (from main menu)
   [Edit Well] (from left-hand menu bar)

By clicking on each well, you can see that there are two groups of wells for this model. Well_1 
through Well_3 have negative pumping rates, which are used to simulate extraction wells. The 
other wells (Flux-1 to Flux-11) located at the Western boundary of the model have a positive 
pumping rate - these are used to simulate a specified flow across the boundary and into the model 
domain. 

   [OK] to close the Edit Well dialogue
To plot the pumping rates for the wells:
 Graph 
 Well_1/Active

The following figure will be displayed.

Total Inflow from Western Boundary = 2750 m^3/day

 Fixed Head at Eastern Boundary = 50m
(Injection Rate per Inj-Well=250 m^3/day)
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 [X] button to close the Graph window 
 Wells>Head Observation Wells 

You can inspect the observed head values for Obs-w_1 through Obs-w_4, the same way you did 
with the pumping wells (using the Edit Obs button). The head observation values are used by 
WinPEST to calibrate the model (i.e. WinPEST tries to find the set of parameter values that will 
minimize the difference between the observed heads and the calculated heads for the model). 

 [OK] to close the Edit Well dialogue 

Grid Extents

In the following figure, the active part of the finite difference grid is super-imposed on the model 
domain. All cells are 12.5 m wide in the X-direction and 10 m high in the Y-direction. You can 
turn the grid off and on by checking or unchecking the Grid-Gridlines features in the Overlay 
Control dialogue, which is accessed by clicking the [F9 – Overlay] button at the bottom of the 
window. 
You can also view cell dimensions using the Grid Editor, which is activated by clicking on 
Assign Elevation/Database from the side menu bar.

Fixed head cells
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Properties

The valley alluvium is divided into three zones. To inspect the property zonation 
[F9 – Overlay]
Prop(F) – Conductivities (this makes the conductities visible with colors)
[...] in the Settings column, and select Outlines 
[OK]
[Apply]

Remove the checkmark  from the checkbox  beside the Grid - Gridlines
[OK]

The property zonation will be displayed in the model (as shown below).

As discussed above, the model has three hydraulic conductivity zones and three storage zones (a 
total of 6 parameters). 
To see the hydraulic conductivity values:
 Properties>Conductivity

[Database] (from the left-hand side menu bar)
[OK]

To see the storage values:
Properties>Storage
[Database] (from the left-hand tool bar) 
[OK]
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Although there are three different zones for conductivity and storage, each of the zones currently 
has the same parameter values, 2 m/day and 0.1, respectively. These are the initial conditions for 
the model prior to running WinPEST. 
Anisotropy is controlled by the Anisotropy factor. In this model, we are using an Anisotropy 
factor of 1 (i.e. Kx=Ky). Since the model has only one layer, the hydraulic conductivity for Kz is 
not essential. Also note that neither Specific Storage (Ss), nor Effective porosity (Poreff), are used 
in this calibration,. Specific Storage is used only for confined layers, and this model does not 
involve confined conditions. The effective porosity parameter is used for MODPATH particle 
tracking, and total porosity is used in MT3D calculations - however neither of these programs are 
used in this tutorial. Therefore, initially there is only one hydraulic conductivity parameter (Kx) 
being used in this model. 

Recharge and Constant Head Boundaries

Groundwater movement within the valley will be simulated for a single year. Recharge, which 
shows seasonal variation, is graphed in the figure on page 4. Given the seasonally varying 
boundary conditions, the modeled year is divided into four stress periods. Each stress period is 
91.3 days in length (totalling 365.2 days) with 15 time steps, and a time step multiplier of 1.2. 
In this model there is a uniform recharge applied to the entire model. To inspect the recharge for 
the model:

Boundaries>Recharge (from the top menu bar).
[Edit] (from the left-hand tool bar). 

There is only one recharge zone (Zone# 1).
[OK]

A Constant Head Boundary is assigned along the right-hand side of the model. To inspect the 
Constant Head Boundary:

Boundaries>Constant Head (from the top menu bar)
[Edit]>Group  (from the left-hand tool bar).

A blank Constant Head - [Edit Group] window will appear
On the brown-colored cells on the right-hand side of the model
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A constant head of 50 m is applied to the eastern side of the domain for a time period of 0 to 365.2 
days.

[OK]

Determination of “observed” values

The following figure shows the water levels observed at the four head observation wells used in 
this model. These observed values represent the calibrated condition for the groundwater system 
being simulated.

     

The objective of this exercise is for you to calibrate the model against the observed values. 
Initially you’ll try calibrating the model manually and subsequently using PEST. First, we’ll run 
the model to compare the calculated and observed values for the initial set of parameters.

Defining Numeric Engines

Before running the model, make sure the MODFLOW 2000 Numeric Flow Engine is selected. To 
exit the Input Menu, click on the F10-Main Menu button. 
From the Main Menu, click Setup/Edit Engines
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Under the Time Options, select Transient Flow as the Run Type.
Under the Flow Options, select USGS MODFLOW 2000 from WHI for the Flow Engine.
 [OK]

Running the Model

Now,
 Run  (from the top menu bar).
 MODFLOW-2000>Time Steps

Note that the model will run for four stress periods of 91.3 days. 
 [OK]

Next, you will modify the solver settings to obtain a “tighter” solution convergence. 
 MODFLOW-2000>Solver  
 WHS

In the Solver Settings window, change the Head change criterion from 0.01 to 0.0001 (the 
Residual criterion for convergence can also be set to 0.0001, but this is not critical). When 
MODFLOW is run under the control of PEST, a tight convergence criterion is necessary. This 
will ensure that PEST correctly calculates the derivatives of the model outputs, with respect to 
adjustable parameters.
 [OK]

Now run the model with the original (un-calibrated) data set. 
    Run (from the top menu bar)
    MODFLOW-2000 (ensure only the MODFLOW 2000 box is checked)
 Translate & Run

After the model has finished running, compare the calculated heads with the observed values. To 
do so: 
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 [Close] to close the VMEngines window
 Output (from the main menu bar)
 Graphs/Time Series/Head (from the top toolbar)

We want to see how far the model is from being “calibrated”—that is, the discrepancy between 
the observed and calibrated values. In the Groups Tab at the left of the window, select All and 
then click [Apply].     
The Head vs. Time plot will appear, similar to the following figure. 

The lines with small symbols represent the results “calculated” by the model, and the large 
symbols represent the “observed” values. With the residual of up to 30 m, the model is clearly far 
from being calibrated.
You may close the Head vs. Time graph and continue with the tutorial.

Manual Calibration

During manual calibration, we are going to assume that recharge is well known and that the only 
parameters that require “tweaking” are hydraulic conductivity and specific yield. As discussed 
above, we have defined 6 parameters, i.e. two parameters in three zones. The challenge now is to 
adjust these parameter values until the modeled and observed water levels in the head observation 
wells match as closely as possible.
It is worthwhile spending some time trying to calibrate your model “by hand”, adjusting the three 
hydraulic conductivity values and the three specific yield values to see if you can get the model to 
generate heads that match the observations. Try manually adjusting the parameters from the 
Input menu, then rerunning your simulation and comparing the results to your previous runs. Fill 
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in the following table with your best estimates of the parameters after you have spent no more 
than half an hour trying to calibrate the model. 

Preparing for Automatic Calibration with PEST

Choice of Parameters

After you have spent some time calibrating the model manually:
Main Menu 
Run (from the top menu bar)
Optimization>Parameter Optimization (from the top tool bar)

In the PEST Control Window, use the “Properties tree” under the Parameters tab to select the 3 
Kx values (the model is isotropic) and 3 Sy values that we want PEST to estimate. 

Parameter Initial Value Best Estimate

Kx_1 2

Kx_2 2

Kx_3 2

Sy_1 0.1

Sy_2 0.1

Sy_3 0.1
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Click on the “+” signs to expand the branches of the tree as needed.
After you have selected parameters for estimation, the PEST Control window should appear as 
shown in the figure above. (Note: your K and Sy values may be different, depending on the most 
recent values you entered in Visual MODFLOW when you were attempting to manually calibrate 
the model).
Now, click on the Table-view icon. 

The display will switch to a table view similar to the following figure. Depending on the latest 
values you entered for K and Sy previously, your “Initial Values” column may contain different 
numbers.
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In the table view, you will see parameter details displayed. Here you can set parameter upper 
(Max.) and lower (Min.) bounds, inform PEST whether a parameter is to be Fixed, Log-
transformed or Is Tied to another parameter, and so on. Furthermore, the Parameter Groups 
section of the dialogue contains the variables that determine how PEST calculates the derivatives 
of the model outcomes with respect to the adjustable parameters. Proper settings for these 
variables can determine the success or failure of a parameter-estimation run. Fortunately, the 
default values for the PEST control variables supplied by Visual MODFLOW are suitable for 
most typical modeling scenarios. 
Visual MODFLOW has automatically set the hydraulic conductivity and specific yield 
parameters to be log transformed – this is always a good idea because of the wide range of 
possible values for these parameters, and because it increases the linearity of the problem. This 
increased linearity makes it easier for PEST to find an optimum set of parameters.
The initial parameter values for the parameter estimation process are the same as those assigned 
to the respective model zones. Edit these values so that all the Kx values are 2.0 and all the Sy 
values are 0.1, the same as you started with for the manual calibration. Notice also that the 
parameter upper and lower bounds have been set very wide apart. By leaving these as they are, 
you can “listen to what PEST has to say” about the model through the values that it assigns to 
these parameters. 
When optimizing (calibrating) a model, it is always best to start off simply and increase the 
complexity only if necessary. To illustrate what can be learned from PEST when the model is 
oversimplified, we will start by assuming homogeneous property domains for Kx and Sy. We will 
do this by tying some of the parameters together so that they are varied in concert with one 
another. Tied parameters retain the same ratio throughout the inversion process. This will reduce 
the number of adjustable parameters from 6 to 2. 
Tie parameters Kx_2 and Kx_3 to parameter Kx_1 by clicking in the Is 
Tied To column, and then on the […] button that appears in the column 
as shown in the figure on right hand side. You may have to make the 
window larger, and the columns of the PEST Control Window wider, 
by dragging their boundaries with a mouse. 
The Parameter transformation window will appear (as shown below) 
where you can select the tied to pull-down menu and then select 
Cndct1_kx, the Kx conductivity for property 1, from the list. 
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Repeat the above for Kx_3. Similarly, tie specific yields Sy_2 and Sy_3 to Sy_1. Note that a 
parameter cannot be tied to another tied parameter – only to an adjustable parameter (i.e. you 
cannot tie Sy_3 to Sy_2). When you have finished, the PEST Control Window should appear 
exactly as shown in the following screen capture.

Definition of the Objective Function

Next we will specify which observations PEST will use to decide whether the model is calibrated 
or not. The combination of these observations is known as the Objective Function. The WinPEST 
interface allows you to specify head, concentration, and flow data as part of the objective 
function. In this tutorial, however, we have observed only head data. 
To specify the objective function:

    Objective Function tab in the PEST Control Window
Since, we have only head data, make sure that only the Head box is checked.  

 Obs-w_1, Obs-w_2, Obs-w_3 and Obs-w_4.  
Your PEST Control Window should now appear similar to the following figure:
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By default, Visual MODFLOW automatically assigned each observation well to its own 
observation group. During the run, PEST calculates the contribution of each group of 
observations to the objective function. 
If you have a lot of observation wells, you can use the observation group function to combine 
observations from different areas of the model into new groups. For example, you may have 
observation wells in three different areas of your site. The observations in the three different areas 
could be grouped together and the influence of each group on the objective function could be 
controlled separately. For example, you might have 20 wells in one area but only 5 wells in 
another area. The calibration in the area with more wells will have a much greater influence on 
the objective function. This can be remedied by assigning a lower weight to the group with more 
wells, so that the two groups affect the objective function more equally. Although we don’t use it 
in this tutorial, the Create New User Group icon, circled in the following figure, is used to add 
new groups to the group database. 

The final step is to select the Controls tab. In this tab are the variables that appear in the “Control 
Data” section of the PEST control file. Visual MODFLOW supports two modes of optimization, 
Estimation Mode and Predictive Mode. Since we are estimating Parameter values, select 
Estimation (as shown below).
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For most cases, the default values supplied by Visual MODFLOW are fine. Therefore, once you 
have inspected these, click on the File menu item and then Save & Exit to close the window.
We are now ready to run PEST.

Predictive Analysis Using PEST-ASP
Predictive Analysis is a form of Goal Programming, where the user asks the program to minimize 
or maximize a specific system response (e.g. aquifer head or groundwater concentration) by 
adjusting selected model parameters within a given bounds, while still maintaining the obligation 
of a calibrated model. By using Predictive Analysis, the modeler is able to replace the traditional 
trial-and-error sensitivity analysis by asking questions such as:

• “What is the maximum contaminant concentration possible at a selected location in 50 
years?”

• “What is the maximum seepage from a section of the river due to nearby pumping?”
• “What is the maximum rise in the water table at a selected location due to irrigation?”

Running WinPEST
RUN (from the top menu bar). The Engines to Run window will appear.
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In this dialogue, select MODFLOW-2000 and PEST.
 Translate & Run to translate the MODFLOW 2000 and PEST files. The WinPEST

window will be displayed as shown below. 

WinPEST will automatically load the correct PEST control file. Once this is complete, we should 
verify the data. WinPEST is supplied with a checking routine, called PESTCHECK, which 
checks the entire PEST data set (including template and instruction files cited in the PEST control 
file) for consistency and correctness. While Visual MODFLOW is not likely to produce an 
erroneous PEST input data set, it is a good practice to run PESTCHECK and it is easily done.
To run PESTCHECK, select Validate/Check All (from top menu bar). If any errors are found, 
the offending file is opened in the dialog, where it can be inspected and edited if necessary. If you 
edit a file, remember to save your changes. Alternately, WinPEST can be closed and the error 
corrected in the Run or Input menus as appropriate. 
WinPEST also provides a wide variety of useful plots that are helpful for 
interpreting the results of the PEST optimization process. To make these 
plots available during execution, select View/Plots from the top menu 
bar and choose All in the Plots to Show window, as shown on the right 
side. Click [OK].
When you are satisfied that all is in readiness for PEST to run, click the 

Run icon , or choose Run from the menu bar, 

Choose Start New Run.
PEST then commences execution. Select the PEST Log tab to monitor 
the real-time progress of PEST’s parameter optimization.
PEST runs a “model” that is actually comprised of two models. These are 
MODFLOW and MODBORE. MODBORE is a program that spatially 
and temporally interpolates from the MODFLOW finite-difference grid 
and time step times to the locations and times of the observations. 
Through these two programs, the “model” produces numbers that can be 
directly compared to field observations. 

Monitoring the Progress of PEST

You can pause PEST execution at any time by clicking the Pause icon . Both PEST and the 
model immediately pause execution. To restart both PEST and the model click on the Start icon. 
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If you click on the Stop button , PEST ceases execution after running to the end of the current 
simulation. You can restart PEST at the same place later using one of two options in the PEST 
Run Options, which can be accessed by selecting the Options menu item, and restarting PEST. 
During PEST execution you can view a number of useful pieces of information, many of them in 
real-time graphical form, by clicking on the appropriate tab. In all of these plots, clicking with the 
right mouse on the graphs and selecting Properties will allow you to alter the appearance of the 
plots.

Objective Function (Phi)

By choosing the Phi tab, you can see the Objective Function vs. Iteration Number. The objective 
function generally declines with each iteration as the residuals decrease, however the objective 
function will not always decline continuously. Clicking on any point on the plot will bring up an 
information bubble containing the values at that point.

Parameters 

The Parameters tab shows how PEST adjusts the parameters with each iteration to minimize the 
objective function. In this case, Kx was increased steadily but little change was made to Sy.
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Because the parameters often range over orders of magnitude, it can be helpful to view them on a 
log scale. Right-click on the plot and select “Properties”. Click in the Logarithm check box of 
the Y-axis frame, then [Apply] and [Close], and the graph will appears as seen below. 

Calculated vs. Observed

Now select the Calc. vs. Obs. tab. A new Calculated versus Observed (Weighted) plot is 
generated at each PEST iteration. Each of the observation groups is plotted with a different color. 
For transient simulations, all times are plotted, and note that the weight is included. The following 
plot is for the final PEST iteration.
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Residuals vs. Observed

You can also view the Residuals vs. Observed value plot by selecting the Residuals tab. The 
following plot was generated for the final PEST iteration. 

Note the difference in scale. However, also note the systematic bias in the residuals: all positive 
for Obs-w_1. This systematic bias suggests that the calibration needs improvement even though 
the residuals have decreased significantly.

Residual Frequency Distribution

The Histograms tab will show a frequency plot of the residuals. The skewed and offset 
distribution exhibited by this model suggests that the calibration needs improvement. This makes 
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sense in this tutorial because we’re representing a trimodal K and Sy distribution with a 
homogeneous system.

Marquardt Lambda

Choosing the Lambda tab will show the Marquardt Lambda vs. Upgrade Attempt. Marquardt 
Lambda is a variable that PEST adjusts to help with the optimization process. Lower values 
indicate that the process is relatively easy for PEST, while higher values indicate that the process 
is relatively challenging.

Jacobian Matrix

In the Jacobian plot, we can see the derivative of the calculated result (Head) at each observation 
point with respect to each parameter. Each bar on the plot represents the derivative of the 
calculated result at a single point in time with respect to a specific parameter. Each grouping that 
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is apparent on the plot represents a single observation well. This set of derivatives or sensitivities 
is generated at each PEST iteration. By right-clicking on this plot you can choose various options, 
including which parameters you would like to see plotted. In the following figure, both Kx_1 and 
Sy_1 are shown. This plot is useful for determining parameter sensitivities at specific locations 
(i.e. the observation points) within the model domain.

Parameter Sensitivities

The Sensitivity tab shows a plot that is effectively the composite derivative of the calculated 
results at all observation points with respect to the specified parameter. As such, the plot gives 
less detail than the Jacobian plot, and more of an overview of parameter sensitivity. 
This model has only two adjustable parameters, Kx_1 and Sy_1. The plot indicates that this 
model is more sensitive to Kx than Sy, given the data available for calibration.
 

After PEST has completed execution, several other parameters are calculated, including 
Covariance, Correlation coefficients, Eigenvectors, Eigenvalues, and Parameter Uncertainties.
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Covariance

Select the Covariance tab to see the structure of the covariance matrix. The diagonal elements of 
this matrix are the variances of the calculated results at the observation points. Those diagonal 
elements with the largest variance are the ones with the highest uncertainty.
The elements provide a measure of correlation between parameters. If two parameters are 
strongly correlated, it means that they can be varied together without producing any meaningful 
change in the model output. For example, if Kx_1 and Sy_1 were both doubled and the model 
output was essentially unchanged, these two parameters would be strongly correlated. This 
important insight into parameter correlation is more easily discerned from the correlation 
coefficient matrix. 
 

Correlation Coefficients

The correlation coefficient matrix under the Correlation tab is derived from the covariance 
matrix, and is easier to interpret. The diagonal terms are always 1 (“large circles”). Off-diagonal 
terms will range from -1 to 1, depending on the degree of correlation. Values near zero (“tiny 
circles”), as shown in the following screenshot, are desirable because they indicate absence of 
correlation. Values close to 1 or –1 are less desirable because they indicate the parameters are 
strongly correlated. Correlated parameters are parameters that can be varied in groups with little 
effect on model output and therefore little effect on the objective function. While each parameter 
may be individually sensitive, the group of correlated parameters is insensitive, thus making it 
hard to estimate each parameter individually. Examination of parameter correlation is at least as 
important as examining individual parameter sensitivities. If PEST is having difficulty in 
reducing the objective function in one of your models, check the degree of parameter correlation. 
If you find that parameters are strongly correlated, PEST is proving valuable feedback on your 
observation data that might not have been noticed otherwise. Specifically, you’ve learned that 
additional observations are required to resolve the non-uniqueness.
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Eigenvectors and Eigenvalues

Insights derived from the correlation coefficient matrix can also be obtained from the 
eigenvectors and eigenvalues. Eigenvectors simply define the semi-axes of the ellipsoids of 
probability of parameters as inferred through the calibration process, as illustrated in the 
following figure. 

This diagram shows two parameters, but eigenvectors are also defined for models with more than 
two parameters, which is when they become particularly useful. Eigenvectors are actually an easy 
way to learn about parameter correlation between more than two parameters. 
To see how this works, click on the Eigenvalues tab. You will see that the eigenvectors are 
ordered from left to right in order of increasing eigenvalue. 
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Each eigenvalue is simply the length of the semi-axis of the probability ellipse of the respective 
eigenvector. Normally the highest eigenvalue is the most important because this is the direction in 
parameter space in which parameters are most poorly estimated i.e. the probability ellipsoid is 
longest in this direction. Looking to the eigenvector corresponding to the highest eigenvalue, we 
can often see at a glance what may be causing problems in parameter estimation. If the model is 
insensitive to a single parameter, the eigenvector corresponding to the largest eigenvalue will be 
dominated by a single component, this pertaining to the insensitive parameter. The following 
diagram illustrates an eigenvector dominated by a single component.

However, if a combination of parameters rather than an individual parameter is poorly 
estimated, more than one of the eigenvector components will be significantly greater than zero. 
The following diagram illustrates eigenvector components of similar magnitude. 
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Each parameter with a non-zero eigenvector component will show some correlation with other 
parameters with non-zero components. By looking at the eigenvectors (rather than the correlation 
coefficient matrix) we can identify all correlated parameters at once. The magnitude of the 
corresponding eigenvalue relative to the magnitude of other eigenvalues indicates the degree of 
parameter correlation. 

In the following screen capture, Vector no. 2 is the eigenvector with the highest eigenvalue. In the 
lower half of the screen capture, you can see that this vector is dominated by a single component, 
indicating that the parameters Kx_1 and Sy_1 are not strongly correlated. 
To see how eigenvector components are added and removed from the display, Right-click on the 
red eigenvalue, and select Add/Remove Eigencomponents. You will see the components of that 
eigenvalue added to the lower plot. You can now see that both eigenvectors are dominated by a 
single component.
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Uncertainties

Selecting the Uncertainties tab, displays the standard deviation. If a warning message appears, 
click [Close].
These standard deviations are a linearized estimate of the uncertainty associated with a parameter 
(note the qualifier that pops up). This plot is perhaps most appropriately used for assessing 
relative uncertainties in parameters of the same type rather than for assessing absolute 
uncertainties.

To inspect a tabulation of PEST-calculated parameter values you need to open the .PAR file. You 
can open and view this file by selecting File/Open/File from the top menu and choosing the file 
valley.par. You may need to change the List files of type combo box to show “PEST parameter 
files (.PAR)”. The parameter values should be about 15 m/day for the alluvium hydraulic 
conductivity and about 0.23 for the alluvium specific yield, as shown in the following screen 
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capture. All three zones have the same value because we tied Kx_2 and Kx_3 to Kx_1, and Sy_2 
and Sy_3 to Sy_1. 

After you have inspected the run time plots, and optimized parameter values generated by PEST, 
return to the PEST log. This log summarizes the history of the optimization process. A more 
detailed history of the optimization process can be found in the file valley.rec (i.e. the PEST “run 
record file”), which is displayed by WinPEST after PEST has finished its execution. 

Head vs. Time

When PEST has finished its run, you can view the transient plot of modelled and observed heads 
for the last parameter combination by re-opening Visual MODFLOW from the task bar. Because 
the lowest objective-function value was obtained in the final PEST iteration, these plots will 
correspond to best parameter estimate obtained by PEST. 
Note:  If the lowest objective function value had been obtained before the last PEST iteration, you 
would run MODFLOW with the optimum parameters before inspecting the output. In this 
example, the lowest objective-function value was obtained in the last PEST iteration so this extra 
MODFLOW run is not necessary. 

Output 
Graphs>Time Series>Head

As seen below, the fit between modeled and observed heads at all observation bores is now much 
improved.
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Summary of Homogeneous Case
So, have we calibrated the model? An improved comparison between calculated and observed 
heads (i.e. low residuals), low correlation coefficients and eigenvectors dominated by a single 
component suggest that the calibration is fairly good. However, the skewed and offset frequency 
distribution of residuals and a systematic bias in the residuals reveals that the calibration may not 
be appropriate. Therefore, the next step in this tutorial will be to “untie” some of the parameters to 
see if the calibration can be improved.

Alternative Calibration - All zones untied

Now let’s “untie” the parameters that we had previously tied. To do this, close WinPEST and the 
Calibration dialogue where the Head vs. Time plots are displayed, and return to the Run menu 
and open the PEST Control Window by clicking the Main Menu button and then selecting Run 
from the menu.

Optimization>Parameter Optimization and select the Parameters tab 
This time, untie Kx_3 and Kx_2 from Kx_1, and untie Sy_3 and Sy_2 from Sy_1. (It is sufficient 
simply to change the transformations from “tied” back to “log”.) Check that all K parameters are 
assigned initial values of 2.0, and all Sy parameters are assigned initial values of 0.1. Check to 
ensure that the wells for your Objective Function are still selected. 

File>Save & Exit 
Now run MODFLOW 2000 and PEST, as before. (Be sure to run PESTCHECK to check that the 
Visual MODFLOW-generated PEST input dataset is consistent and correct).
Note that PEST took longer to run because it is solving for three times as many parameters (six 
adjustable parameters instead of two). At each iteration PEST now needs to run the MODFLOW 
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model six times for one-sided derivatives and 12 times for two-sided derivatives. When PEST is 
complete, retrieve the .PAR file.

You can also see how PEST adjusted the values of these parameters during the optimization 
process, as shown in the following figure. 

Recall from the “tied” simulation that the Residuals vs. Observed Value plot showed that the 
residuals were all negative or all positive for each well. In this case, however, we do not see such 
a trend and the residuals are also much lower. 
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Similarly, the frequency distribution of residuals is no longer skewed, and it more closely 
approximates a normal distribution, suggesting that the calibration is improved.

Under the Phi tab, the Calibration Residuals Histogram indicates that the objective function 
declines with each iteration as the residuals decrease, the same as our previous simulation. The 
objective function reaches a minimum value of 0.0018, which is approximately two orders of 
magnitude lower than the homogeneous case.
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The following screen capture illustrates that K is the most sensitive parameter in all zones. The 
higher sensitivity of K implies that this parameter is more accurately determined than Sy.

The correlation coefficient matrix indicates that Kx_1 and Kx_3 are the most strongly correlated 
parameters, followed closely by Sy_1 and Sy_2. However, the coefficients are all less than 0.8, 
suggesting that the parameters are not too strongly correlated. Coefficients as high as 0.9 would 
be cause for concern.
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Finally, back in Visual MODFLOW, we can again view the Head vs. Time plot in the Output 
module, which shows good agreement. Because of the scale of this plot, improvements from the 
homogeneous case are undetectable. This similarity indicates the importance of the other 
calibration plots to determine the quality of the calibration. 

Summary
So, what are we to make of this? The parameters used to generate the “field data” are listed in the 
following table. PEST was able to do a good job of replicating these values.
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The following conclusions can be drawn from this Tutorial:
• PEST will minimize the objective function regardless of the conceptual model that is 

provided;
• Output from the PEST optimization routine can be used to assess whether the conceptual 

model is reasonable and, therefore, whether the calibration is as good as possible;
• Detailed examination of calibration plots is required to determine the quality of a 

calibration. A minimized objective function does not guarantee a good calibration;
• The ability of PEST to provide a good calibration is significantly improved when the 

conceptual model provided approximates more closely the actual field conditions;
• PEST is often capable of quickly providing a more accurate calibration than manual 

methods, especially in problems that involve many parameters and observations.
• Fast insight into the quality of the calibration, such as parameter correlation, is possible 

using PEST. Manually it would take longer to assess this information..
This concludes the WinPEST Tutorial.

Zone K Sy

1 22.6 0.304

2 10.9 0.193

3 6.0 0.099
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